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Introduction

Document Conventions Used:
» This Excel system is called Portfolio Manager.

Items in Red are worksheet names within Portfolio Manager.

Items in Purple are system settings that the user can change on the Settings Sheet.
Items in Blue are column names used within a worksheet.

Items in Brown are column letters within a worksheet.

Items in Green are Portfolio Manager menu selections or button names.

vV V. V V V VYV

Menu operations are annotated using the “->" notation eg “File -> Save As [ALT+F+S]”
means from the menu select the “File”” menu then select the “Save As”, or you can use
the keyboard short cut keys holding down Alt key and pressing F and the S keys

» Programmable Function keys 1 to 12 are denoted as F1 to F12.

System Requirements

You must have Micro$oft Excel97 or later installed to use Portfolio Manager. If you are using
any of the web enabled features you must be logged on the internet and allow Excel to access the
internet if you have a firewall installed.

You will also have to enable macros within Excel. To enable macros in Excel use “Tools ->
Options” select the “Security” tab and click on Macro Security and select Medium or Low.

Portfolio Manager Overview

This web enabled spreadsheet was designed to record all details for a share portfolio. It has been
written as a MS Excel spreadsheet that uses VBA code. It will leave no “footprints” (ie registry
entries) on your system and everything is completely recorded within the spreadsheet.

The system also is web enabled in that it is capable of downloading stock prices from any
exchange in the world, however it has been designed for the Australian Stock Exchange and the
Australian Taxation System.

The system will allow you to record:

> Your current share portfolio

»  All sold shares and their capital gains

» All Dividends

» Up to three separate cash bank accounts
In addition the system will also:

» Provide limited charting

» Provide limited share information

» Actas a “watch list” for selected stocks

>

Alert users when shares are at or near “BuyAt” and “Sell At” points.

Start up and Applying a Registration Key
When you initially start Portfolio Manager you will receive the following splash screen:

http://portfolioman.atspace.com
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Your Licence No is: L1234567890123 i ﬂ

Portfolio Manager [Ver: dd/mmm/nny]

This is a TRIAL version and it is limited to 5 stocks only.

If wou already have a Reqistration Key please enter it and click on "activate ..." —
Feqistration Kew: I Activate Portfolio Manager
Mo, T just want ko ke ik | éies, I would like to Purchase/Renegw

This window will only appear when there is no Registration Key found for the Licence Number, or
when your current Registration Key has expired. If you don't enter a Registration key then
Portfolio Manager will work in Trial Mode only, which will limit the system to five stocks.

The Licence Number generated will be unique and if you wish to purchase a Licence then your
Licence Number (L1234567890123 in the above example) will have to be emailed to me where
upon a Registration Key will be emailed back to you. The Registration key will unlock the
software from trial mode.

If you click on the Yes, | would ... button then you will be taken to the OrderForm worksheet.
Your generated Licence Number will be filled in for you, and all you have to do is fill in your
details, copy the order to the clip board (via the Copy button) and email it.

When your order is received, a Registration key will be emailed back and and once this
Registration Key is entered and Activate Portfolio Manager is clicked, then your Licence
Number and Registration Key are saved in your Settings and your software will be activated.

When you re-open Portfolio Manager it will advise you of the expiry date for the Registration
Key. In the event of the expiry of a Registration Key, you will need a new Registration key to
reactive Portfolio Manager.

1.5 General Advice

It is recommended that you do not attempt to delete or move the position of columns as this will
most likely cause the software to fail, there are a number special menu buttons that will allow you
to customise the columns and rows displayed.

You may rename most worksheets tabs and you should only manually delete rows via the menu
option “Special -> Delete Selected Rows [ALT+P+D]”. You may also add your own worksheets
and add any extra columns to the end of the existing worksheets.

Automatic calculation has been turned off (for performance reasons) when you open a fresh
version, so to force a recalculate you must use F9 key. You may turn this feature on (via
[ALT+P+R]) and via Automatic sheet recalculation option on the Settings sheet.

All operations for Portfolio Manager should be performed via the custom menu bar and most
worksheets are protected to stop accidental modification and/or deletion for formulas. This
protection can be turned on and off via [ALT+P+F] or [ALT+P+0O].

If you do manage to corrupt any of the formulas then doing an Upgrade (even to the same version)
should repair any damage.

1.6 Getting Started:
If you are a new user to Portfolio Manager, here is a check list of what you should do:

1. You will need to send me your Licence Number via “Special -> Order Form” or by
clicking on Yes, | would like to Purchase/Renew. This will take you to an Order Form
where you can fill in your details and click Email Order. When you have received your
Registration Key enter it in the initial start up window and click the Activate ... button.

2. Before you start entering your data, have a play around with the software to familiarise
yourself with how you do things, after all you can have as many copies as you wish to
play with.

http://portfolioman.atspace.com pmacgowan@gmaill.com or pmacgowan@iinet.net.au
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3. Make sure the Stocks worksheet contains all the stocks you are going to deal with. If not
add your stocks on the end of Column A, then click Load ASX or Load Yahoo to load
current share prices. If you want to load non Australia stocks then select the exchange
from the drop down on the Load Yahoo button and enter the exchange code in column B.

4. Make sure you have your broker(s) defined (if it is not already there) in Brokers, and the
correct brokerage fees (GST inclusive) have been defined.

5. Check, review and change User Settings in the Settings worksheet to suit your needs.
Some of the default values may not suit your needs, for example if the portfolio is for a
Super fund then set Tax Rate after 12mths to 66.666667%b.

6. Go to the Portfolio worksheet and do Buys and Sells to setup your Portfolio. In the Buy
& Sell screens always use the dropdown arrows to select the value you want, once
selected you can scroll up and down via your keyboard up and down arrow keys. You can
enter any dates in any of the buy and sell screens.

7. Resave your Portfolio using a different name other than “Portfolio.xls”. If you leave it
with this name it will prevent future upgrades.

The key aspects to remember with this software are:

» ltis all table driven, in that it is up to you to have appropriate values (in sorted order)
in the lookup tables Stocks, Brokers, Trans, Actions and Settings.

» Itis only a fancy spreadsheet so you can overtype any values (but not the formulas) on
any of the sheets and use F9 to recalculate. If you make a mistake in the popup screen
entry, then you can still overtype any of the data values, just don't change any of the
formula cells.

» The Portfolio and Sold-yyyy entries are automatically generated for you via the Buy,
Sell and Add Dividend Screens, however there is nothing stopping you from altering
any of the cells or deleting rows to undo an action.

» If you do stuff up some of your data, just don't do a save, close it without saving and
reopen it and the changes will have gone.

»  When you have your Portfolio all in and up to date then please follow the maxim
BACKUP EARLY AND BACKUP OFTEN. Use the Backup... option on the Special
... menu every so often. Given the often complex nature of the data it is easy to stuff
something up, in which case you can still revert to your backup copy.

» It does not write to the Registry and can be safely deleted just like any other Excel
spreadsheet. In other words, it does not leave any foot prints and ALL information is
held within the one spreadsheet.

That's the whole system, simple to use, cheap, web enabled, doesn't require specialised software
and runs as a standard Excel spreadsheet.
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2 Portfolio Manager Worksheets

2.1 Worksheets Cash (and Cash2 and Cash3)

NOTE: If you have changed the setting | will be using the cash account(s) to No then these
buttons will not appear and if you have renamed the worksheet tab then the names of these buttons
will also change to match the tab name.

E3 Microsoft Excel - PF-Demo.xls =lol x|
File Edt Miew Insert Format  Tools Data  ‘Window Help Type a question far help

D2 EGRAY SRR v-a-|@& = -8 2] | i@ -3,
fa*a ™ S E @gﬁ *  arial

5 w0 | = 5
$ 2% 5 s |

&’J Load AS% | Load ¥ahoo AS¥ = | Buy  Sell $Cash | $Cash2 | $Cash3  ++ AddDividend | Add... =  Share Info... = | Special... *  GoTo.. = .
c2 - fir
A B C D E F G H | ] I K B
1 |Fin¥T Date Trans| Dehit Credit [Cheque No|StatNo|TxnlD|Recon Amt|C \Primary Cash Acco.J
2 [93/00) 01/May/2006 - 0.00
| 3 | Bc:ge ~{ 0.00 0.00 0.00
] 52 Hrance:
| 5 |
7

Ready Calculate

Sold-0506 ' Div JE3 N ﬂﬂ
4

These worksheets allow you to record all the debits and credits from your cash account(s).
Clicking on the $Cash/$Cash2/$Cash3 buttons (or “Add... -> Cash2/Cash3”) will create a new
cash entry. The dropdown list for in the Trans column is linked to the Trans worksheet where all
your possible cash transactions types are recorded. You may modify the transactions types or add
new transactions codes as required.

Column StatNo is used to record the statement page number and the column Txnld is used to
record a sequence number within each statement. The Txnld is a number that you assign and it is
recommended that for each statement you write a sequence number against each transaction.

To aid the reconciliation process, when both the StatNo and Txnld are entered the total amount

will appear in the Recon Amt column. The Total in column I can be used to balance against your
bank statement.

You can use the auto filter button to get Individual statement subtotals for statement
reconciliation.

2.2 Worksheet AutoCash (From Version 8/May/2006 only)

53 Microsoft Excel - PF-Demo.xls =10 5[
@ File Edit “iew Insert Format  Tools Data  ‘Window Help Typeaquestionforhelp = 2 & X
CEEE SRY 4@ - o-c-@=- 43 @0 -0,
Bt a=@ ¢ Ee 25 el s - B U SE=E=E S %, BB EE L -SA
IE| Load ASY | Load Yahoo ASK ~ | Buy | Sell | §Cash | $Cash? | $Cash3 | £% AddDividend Add... =  Share Info... ‘? -

C3 ~ Fe

Al B | C D E F G H 0 T ok L [ m [N ] czi
1 |Acct|Start|End|  Frequency Next Trans| Amt |Ci I—|
201 Fortnightly 01/May/2006|Emr  |500.00 [Super
3] 2 Monthly[LastDay]| 31/May/2006|Fee -5.00 |Acct Fee
4 -
M 4 F M PriceData-2a0-1mo Chart-¥OHLC { Chart-Close ¢/ Exchanges { Brokers £ Trans ¢ Actions  CPL 48 a ¥ Settings Jil LI
Ready v

This worksheet allows you to define any automatic cash transactions that can occur on any of the 3
cash accounts. These transactions will automatically created for you each time you open portfolio
manager or when you do a menu refresh. You will be alerted when any transactions are
automatically created.

http://portfolioman.atspace.com pmacgowan@gmaill.com or pmacgowan@iinet.net.au



Version: 8/Aug/2005 Portfolio Manager User Guide Page 8 of 32
2.3 Worksheet Portfolio

E3 Microsoft Excel - PF-Demo.xls =10 5'
File Edit “iew Insert Format Tools Data  Window Help Type a question for help [« 2 & X
DeEm SaY & BE-F |- o @ =2l 4w -3
[ Rl B e = W S 2 Arial -0 -|B 7 U|= B %, %[ E DA
[ Load ASK | Load Yahoo ASX + | Buy | Sell | $Cash | $Cashz | $Cashd | £+ | AddDividend A&dd..~  Share Info.. = Special..~ | GoTo.. = B2 7.
E2 - £ AGL
A B c D E H | J K L i} N 0 P Q R 5 Al
1 |Fin¥r Date Action [Bkr |Share | #Shares| Price|BuyWalue | Brokerage| GST | SDuty| CapRet| $Buy 5%)] StLoss| SellAt] Last F\J
| 2 |05/06|01/Dec/2005(Buy  |QTD JAGL 309|16.150| 4,890.35 10.00( 1.00] 0.00 5,001.35|17.09| 12.110] 24230 16.
| 3 | 0506 31/0ct/2006(Buy  |ETO (STO 2,200]11.350| 24 570.00 10.00) 100 0.00 24981.00(11.94) 5510 17.030 1"
| 4 |05/06] 25/Ccti2005(Buy  |ETD |TOL 1600(12.200( 19,520.00 29.85| 3000 000 19,552.95(12.85) 9.150)18.300 13;
5 |05/06 | 25/0ct/2005|Buy  |ETD [TLS 5,000] 4110 20,550.00 28.856) 3000 000 20,582.95| 4.33] 3.030) 6170 3.
| B | 70,030.35 7990 8.00 0.00 70,118.25
WoAar Portfolio AR 03 4 & Sold-0506 4 Dividends A8 RN
Ready v

This worksheet will record all the details about your current share portfolio and will allow you to
see its value (with 20 minute delay). You should not attempt to add or delete (except via “Special -
> Delete Selected Rows [ALT+P+D]”) any rows yourself, instead use the Buy and Sell buttons.

Columns Share, Name, Sector and Last Price are linked to the Stocks worksheet and so any
change in the Stocks worksheet will be reflected in these columns.

Cell P1 (in brown) may also be changed to any Percentage, and when F9 (recalculate) is used it
will display the share price required to make the % return (allowing for brokerage, GST and stamp
duty defined in Brokerage and Settings worksheets). Setting it to 0% would give you the “break-
even” price.

Columns Q & R display the Stop Loss and a Sell At price of your share. These columns are
calculated based on the percentages specified in the Settings worksheet. You may change these
generated values if they do not suit your needs. When the price of a stock is within 5% of the Stop
Loss or Sell At the price is highlighted in orange. When the share price reaches the Stop Loss it is
displayed in red and when the price reaches the Sell At it is displayed in Green.

The blue columns give you all the information about what the portfolio shares are worth if they
were to be sold today, at the current time. Your brokerage and GST (column V and W) are all
worked out using the broker you have in Bkr (column D).

The broker code is looked up in the Brokers worksheet and it is the broker that is currently
holding your shares in CHESS, not the broker that you bought the shares in, this can be found out
from the Log worksheet. If you move your shares from one broker to another then you should

overtype/change this code so that the system correctly works out the brokerage if you were to sell
today.

At the bottom of your portfolio the totals in columns Y, Z and AA will give your total profit/loss
position of the entire portfolio.

2.4 Worksheet SoldTot

Ed Microsoft Excel - PF-Demo.xls
File Edit View Insert Format Tools Data  Window  Help Type a question for help =
DR &SGRV $BER-< o- - |@& 2 -2 2l ||l 40 -3,

Bt ATE DEE 2 - -[[=]z u|E] Bl %, @EEo-0-A
E’] Load ASX | Load Yahoo ASH - | Buy | Sell | $Cash | $Cash2 | $Cash3 | £% | Add Dividend | Add...~  Share Info... = | Spedial.. = | GoTa... = [ H
Al - Fe
A B c D E F G H | J Tk T L]

| 1 |FinYear|Net Profit Tot Gain |Loss Prev ¥r |Net Gain |Loss Next Yr|Tax Gain |Tax Rate |Tax Payable
| 2 [1997/98 11.10 11.10 §0.00 11.10 11.10 31.5% 3450
| 3 [1999/00 | 1540.45 | 1,340.45 1,840.45 1,540.45 31.5% a78.74
| 4 |2000/01 |-5027.50 |-5,027 50 5,027 80 %5027 .50 31.5%
| & |200102 | 1964.05 | 196405 -55,027.50(-3,063.45 -53,063.45 31.5%
| B |2002/03 2534 2534 -53,063.45(-3,035.11 -53,038.11 31.5%
| 7 |200304 | 592365 | 592365 -53,035.11| 5,885.54 1436.37 31.5% 452,45
| & |200408 52405 | 52405 524.05 524.05 31.5% 165.08

9 2005406 | -1.290.52 |-1,290.52 -1,290.52 -$1,290.52 31.5%
| 10 | 6,970.62 | 6,970.62 1,200.77 -
TR Cash i 0 [ st Llj_‘
Ready

This worksheet is automatically created and maintained by the system to calculate appropriate
totals for each financial year. You should not attempt to add or delete any rows and the only
column that you can change on this worksheet is column H (Tax Rate).
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You will be prompted via the following popup:

Please select Marginal Tax Rate for 2000; x|

Marainal Tax Rates:

15.0% O 165% 0 31.5% ( 43.5% O 45.5%

to select the Marginal Tax Rate when a new row is created in SoldTot. If you ever want to alter
this rate, then just overtype is value in column H.

2.5 Worksheets Sold-yyyy

E3 Microsoft Excel - PF-Demo.xls — 0] x|
File Edit Wiew Insert Format Tools Data  Window  Help Type aquestion forhelp = 2 & X
DEEY SRY | $BER-T o- o |8 22 % 4w -0,

Gt A | L e ? - Al -0 - B I UE=E=EE 8%, WU EE DAL
[ | Load ASX | Load Yahoo AS% ~ | Buy | Sell | $Cash  $Cash2 | $Cashd | €% | Add Dividend | Add..~ ShareInfo... ~ | Spedal.. = | @oTo..~ | BH B3 |5 | @ .

A2 hd e 1/12/2005
A B c o E F G H | J K L Il Nz

1 ell Date | Bkr [Share Name #Shares| Price | Value |Brokerage |GST|SDuty| $Sell Buy Date | BuyPrice | BuyB

2 |01/Dec20051QTD (AGL  |AGL FRO 308(16.150| 4,890.35 10.00| 1.00( 0.00| 4,979.35( 01/Dec/2005 16.150 1ﬂ
| 3 | 11/A0g/2005]|QTD (BEN  |BEM BANK. FRO 500{10.060| 5,030.00 2641 254 0.00) 5,002.05( 1154002005 10.000 2£
| 4 |09/Aug2005|QTD (TLS  |TELSTRA CORPORATI a00| 4.960| 2,480.00 2541 254 0.00) 2,452.05| 18/0ct 1999 7.400
| 5 |02/4ug/2005|QTD |CML  |COLES MYER FPO 3| 9.830 29.43 5.45|054| 0.00 23.50] 10/May/1999 7.060

B |09/A00/2005|QTD |CML  |COLES MYER FPO 11] 8.830] 108.13 19.96) 2.00] 0.00 86.17| 10/May2004 7.560
| 7 | 12,637.97 86.23 8.62 0.00 12,543.12 3,
TRk Cash / Fortfolio / SoldTot  Sold-ooo1 ‘ Sold-0102  Sold-0304 4 Sold-0405 ¢ Sold-0203 . 5old-0506 T, 5t 4] L”J
Ready

All the details in these worksheets are automatically generated when a Sell is performed on the

Portfolio worksheet. A new Sold-yyyy worksheet will automatically be created for each financial
year.

Your total trading profit/loss is recorded along with the Tax due (using the old indexed or new
discount system). Columns W to AA relate to the old CGT (Capital Gains Tax) system before
22/Sep/1999 and the CPI worksheet is used to derive the CPI (Consumer price Index) adjusted
Profit in column AA. The blue fields can be altered manually if required.

If you have non Australian shares then you should ignore columns W to AB as they only relate to
the Australian Taxation system, if however your shares are Australian then the system will
automatically select the best tax system in column AB when you do a sell.

The examples given in the ATO Guide to Capital Gains Tax book have been tried to verify that the
CGT calculation figures are correct. It is recommended that you examine this ATO publication if

you are unsure about CGT calculation. It is your responsibility to ensure that the derived amounts
are in fact correct.

At some point you may want to delete older Sold-yyyy worksheets (ie older than 7 years etc), and
you can do this but if there was a loss being carried then you should include this loss in Initial
Starting Tax Loss to maintain the same totals.

If you do delete an older Sold-yyyy worksheet the system will regenerate the SoldTot worksheet
when you next reopen your Portfolio.

2.6 Worksheet Dividends

Ed Microsoft Excel - PF-Demo.xls =]
() Ele Edt Vew [set Fomat Jook Data  Window Help Type @ question forhelp [+ = @ X
DR SRV $BBR-T o-o- 8 =25 aHoe -0,
{3 "3 %3 A @ KA | (2] B 2 | ¥ reply with Changes... End Review... , & Arlal .0 .| B T U= * B %, Y .
[ LoadAs¥  Load¥ahoo ASX v Buy | Sel $Cash | §Cash? | §Cash3 43  AddDividend | Add...~ | ShaeInfo.. > | Spedal..~ | GoTo. = B8 7.
A2 - A =MDa
A ] B e | D E F G H ] 1 J ] 0] [5] P 1=
[ 1] Stock |Name Cents Per Share |DRI Shares | DRI Div WhTax CapRet |Fees| NetTot |Gross Tot E_'
[ 2 [0506] 11/Aug/2006[WOW  [WOOLWORTHS FPO 238.07| 289.41 28808| 79357
| 3 [04M5| 30¢Apw2005|TLS  |TELSTRA CORP FPO 13 94.71 221000 3E71
[ 4] COLES MYER 14 11| 836 3564 6316  118.80
|5 | CMLPA |COLES MYER-PREF 124.30 200.04 414,34
£ 10304 210,00 210,00 zm?n =
RO, svldTot ¢ Sold-000 Dividends { stocke { Byshare  Bysector  ByTime  ByTmeData [ FriceDatar [«] [ »
Ready v

This sheet records all Dividends and Capital Returns for your shares. You can create a new entry
by clicking on a share row in Portfolio (or Sold-yyyy) and click on the Add Dividend Button.
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You also have the ability to enter dividend reinvestments (DRI) by entering the number of DRI
Shares and their cash value, the system will then also create an entry in the Portfolio worksheet to
represent the DRI buy. Entries in the Cash,Cash2 or Cash3 worksheets will also be created if you
have nominated a cash a account to credit.

When a Capital return amount is entered it will be automatically applied; to column N in
Portfolio; across all holdings for the selected stock across your portfolio.

If your dividends have any withholding tax or management fees deducted, then you can also enter
these details and they will also be recorded the Dividends sheet.

2.7 Worksheet Stocks

Ed Microsoft Excel - PF-Demo.xls =10 x|

File Edit Yiew Insert Format Tools Data  Window Help Type a question for help [+ _ & X
DSHE|GRY|$B@B-F o-c-|@E-HF WHo -0,

At aaal 2 se » - il 8 B rUEEEE 3%, B0 EE A AL

B | Load AS¥ | Load ¥ahoo ASx » | Buy | Sell | $Cash | $Cash2 | $Cash3 €3 | Add Dividend | Add... ~ | ShateInfo...=  Sperial..~ | GoTa...~ B 57 .

A2 b B AGL
A B c 8] E F G H | J K L i} N © P =

1 |Code |Mkt |Company Hame Sector Buyit|SellAt] Last § +. |Daiby Gain | Bid | Offer | Open | High | Low Volume | %Change =

2 |acL A5 (AGL FPO Australian SE 16.150)-0150 -27510 16.150|16 240(16.070| 1,177 659 318%

3 [apa AZH AU PIPELIN UNITS Ltilities 3.870)-0.030 3.910( 3820 3870 243,558 0.66%

4 |BEM ASH |BEN BAMK FPO Banks 11.920)-0.080 11.800012.000] 11860 123,584 -0.03%

5 |cBa ASH [CWLTH BAMK FRO Banks 41140/ -0 BGO 41.550041 67041 130| 4215331 1 .B5% =
= . B -
TR - 0001 { Sold-010 0 506 f Bl Stocks 4 Byshare 4.8« ] >|J
Ready i

This is where the power of this system comes into play because all the stock details are obtained
directly from the Australian Stock Exchange web site via Load ASX or Yahoo Finance (based on
what is selected in the dropdown box) via Load Yahoo. The Stock codes Names, Sector and
Prices (columns A, C, D and G) are all linked back into your Portfolio worksheet.

Column | (Daily Gain) is based on the total number of stocks you hold multiplied by the change in
price in column H. A total gain (or loss) is also generated at the end of column 1.

Column D (Sector) is derived separately from the ASX and you will be asked if you want to load
the sector if any are blank. You can of course enter the sector yourself. The sector is used in the
Portfolio and BySector worksheets. To load any sectors requires about 80k of downloaded data to
be processed.

If you want to just reload the sector names then just clear out all the values in the Sector column
and then use Load ASX.

Add any additional ASX codes at the end of column A (Code) and then click on Load ASX or
Load Yahoo and the latest price details for all stocks will sorted and be returned (with a 20 minute
delay) from the ASX/Yahoo web sites (you will of course, have to be logged on the internet for
this function to work).

Column P (%Change) is highlighted in Green and Red to indicate rises and falls. If this column is
bold then it has had more that 5% change, and if the column is a larger font then is has changed by
10% or more.

Cell R1 contains the last date and time you loaded prices (or last time market was open), and
column S1 is a hyperlink to the ASX prices.

NOTE: If you are getting errors via a message box while trying to load prices, it normally means
the ASX/Yahoo site is either down or too busy. Firstly try the other price load button but if these
errors persist then it is recommended that you use your browser to try and display stock prices,
this will establish if the problem lies with the ASX/Yahoo or Portfolio Manager. From time to time
the web sites accessed can change their URL's and/or behaviour. So a change to the Settings may
be required, in such a case you will be advised how to fix the problem by entering a new URL in
your Settings.

2.8 Worksheet Exchanges

This worksheet defines all the stock exchanges around the world and you should not attempt to
change any values in columns A to E unless directed. You can however enter an exchange rate
in column F. Any non zero exchange rate is then applied in the prices in the Stocks sheet when
you do a Yahoo price load.
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2.9 Worksheet Trans[actions]

This worksheet defines all the valid cash transaction codes used in the Cash worksheet (see 2.1
above). You may add/delete or modify these codes to suit. To add a new Cash Transaction code
click on “Add... -> Cash Transaction Code”.

2.10 Worksheet Actions

This worksheet defines all the valid Buy action codes. It also defines if the action will generate a
Cash debit transaction and if the action is subject to stamp duty and/or brokerage. To add a new
Action click on the “Add... -> Buy Action Code”.

For example an Off Market transfer is subject to stamp duty (prior to 1/Jul/2001) but is not subject
to brokerage so the flags have been set accordingly for the OffMT code.

2.11 Worksheet CPI

This worksheet defines all the CPI rates for every quarter. This information is only used if you
sold a stock that had been purchased before 22/Sep/1999 and you held the stock for a least 12
months. The Sold-yyyy worksheet uses this worksheet to calculate the Indexed taxable values.

You should not need to alter this worksheet since it only relates to the older indexed Tax system.

2.12 Worksheet Brokers

This worksheet defines all the stock brokers available in the system. Each broker is assigned a
code and if your broker is not there then all you have to do is click on “Add... -> Broker Code”
and enter a broker code (your choice) and its details.

Column Min1 defines the lowest brokerage up to UpTol.

Column Min2 define the next minimum level of brokerage up to UpTo2. This is left blank if the
broker has no 2nd level of minimum brokerage.

Column Rate defines the brokerage rate if the amount of the trade is greater than the minimums.
NOTE: All details entered in Brokers are GST inclusive.

2.13 Worksheet ByShare
This is a pivot table showing your portfolio broken down by share.

You will not need to change this worksheet; all details are automatically generated when you
click on the ByShare tab.

2.14 Worksheet BySector
This is a pivot table showing your portfolio broken down by sector.

You will not need to change this worksheet; all details are automatically generated when you
click on the BySector tab.

2.15 Worksheet ByTime and ByTimeData

This is an automatically generated graph (and data sheet) over time of your Portfolio, Cash, Profit
and Total.

You will not need to change this worksheet; all details are automatically generated when you
click on the ByTime tab or when you close Portfolio.

2.16 Worksheet Log

This is a record of all buys, sells, takeover and conversions performed, the details are
automatically generated. You can however manually add or correct entries if required.
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2.17 Worksheet Chart-Close and Chart-VOHLC

These two worksheets contain Charts that are generated from the PriceData... worksheet data
when you use the “Sharelnfo -> Chart ...” options. The stock code is derived from the selected
row, if it cannot be derived then you will be prompted.

2.18 Worksheet OrderForm

If you want to purchase Portfolio Manager this worksheet will allow you to create an order, which
can then be sent via email or other means. Once you have filled in your details click on the Copy
button and send the order via email using windows Paste.

2.19 Worksheet Settings
This worksheet is used to define all system wide settings. There are three blocks of settings in
Blue, Brown and yellow.

All “User Settings” in blue can be changed to customize Portfolio Manager to suit your needs.
These settings are:

2.19.1 Settlement Days

Used when generating a cash transaction. The Settlement Days value is added to the dates for Buys
and Sells. This is a working days (Mon - Fri) calculation.

2.19.2 Current GST Rate for Brokerage

This is the current rate of GST (10%), and will be applied to the total brokerage for Buys and
Sells.

2.19.3 Stamp Duty - Cents per $100

This is the Stamp Duty rate for all trades. With the abolition of Stamp Duty from 1/Jul/2001
then this should be set to 0 after this date, otherwise it is $0.15 cents per $100.00 or part thereof.

2.19.4 Company Tax Rate

This is current Company Tax rate and it is used when deriving the franking credits on the Dividend
screen when you enter the cents per share.

2.19.5 Inormally buy shares in lots of

This allows you to set a default $ amount for a buy. The numbers of shares generated as a default
will be approximately this amount.

2.19.6 Initial Starting Tax Loss

If you have a tax loss that you want to carry from previous years, that will is not recorded in
Portfolio Manager then you can specify the amount in this field. It is used when displaying your
net position on the Portfolio and Sold-yyyy worksheets.

2.19.7 1will be using the cash account(s)

Setting this option to No will default Cash account options to None in the Buy, Sell and Dividend
popup screens, it will also suppress the $Cash buttons on the menu bar. You can also nominate
One or Two if you are only using one or two of the cash accounts.

2.19.8 Full breakdown on Cash for buy/sell

If this option is set to Yes, then when a buy or sell and a Cash transaction is generated it will also
create separate entries for brokerage, Stamp Duty and GST in addition to the actual buy or sell, if
this option in No then a total net amount is generated in the relevant Cash worksheet.
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2.19.9 Clear PriceData when closing

If the option is set to Yes, then the worksheet PriceData-... will be cleared, this will help reduce
the size of Portfolio Manager when you save it.

2.19.10 Automatic sheet recalculation

If the option is set to Yes, then the whole workbook will do a recalculate each time any value in
any sheet is changed. In some cases you will find that this may cause there system to slow down.

2.19.11 Auto Price Load every # minutes

This will be set for you when you turn On or Off Automatic price loading, ie “Special ->
Automatic Price Load”. It has been made a setting so that it will be remembered when you
reopen Portfolio Manager again.

2.19.12 Include Quarter in all FinYr Columns

If the option is set to Yes, then the Fin Yr columns on Portfolio, Dividends, Cash, Cash2, Cash3
and Log will also display a quarter suffix.

2.19.13 My Default Broker for Buy is

When you do a Buy in Portfolio this is the default broker code that will be initially set in the
Broker input box.

2.19.14 Internal Settings

These settings are for internal use only, do not attempt to change them unless directed. In cases
where a web site URL changes then you may be provided with the new URL(s) to enter.

Your current License Number and corresponding Registration Key are recorded in this yellow
area.

When you enter your Registration Key in the initial start up window (see 1.4 above) it will be
recorded and saved in this area.

If you want to start a new Portfolio then you can just copy a previous License Number and
Registration Key into these field and providing that are valid then everything will continue to
work.

NOTE: If you have been issued a trial Registration Key then that key will only work for that PC,
otherwise the standard Registration Key will work on any PC.
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3 Portfolio Manager Custom Menu

3.1 Menu Introduction
All operations in Portfolio Manager have be designed to operate via its own custom Menu Bar:

Ed Microsoft Excel - PF-Demo.xls - |E||1|
File Edit Wew Insert Format  Tools Data  Window Help -8 X
DEEdE SRV | BBR-F|v-o- & =2 3|4

BathatE HEe 2 o L|lB 2O

FIEIEIE |

| [Qj Load AS¥  Load Yahoo A5% = | Buy  Sel | $Cash | $Cashz | $Cash3 <% | addDividend | Add... = | Share Info... v | Special., = | GoTo...
E2 - A AGL
A B © D E H | J K L Il i o P Q R ]
1 |Fin¥r Date Action |Bkr _|Share |#Shares| Price| BuyWalue | Brokerage| GST | SDuty| CapRet| $Buy 5%)| Stl oss| SellAt Las’J
| 2 |05/06|01/Dec/2005|Buy  |QTD [AGL 309]16.150| 4990.35 10.00| 1.00| 0.00 5,001.35| 17.09| 12.110{24.230
| 3 |05/06| 31/0ct/2005|Buy  |ETD [STO 2.200|11.350| 24 570.00 10.00| 1.00| 0.00 24,981.00(11.94| 8.510|17.030
| 4 |08/06 | 26/0ct/2005|Buy  |ETD [TOL 1,600(12.200| 1952000 29,95 3.00{ 0.00 19,952.95|12.65| 9.150{18.300
5 |05/06| 25/0ct/2005|Buy  |ETD |TLS 5.000] 4.110] 20,550.00 29.95 3.00[ 0.00 20,582.95| 433| 3.080) EA70
| B | 70,030.35 79.90 8.00 0.00 70,118.25
oldTot  Sold-0001  Sold-9900 4 Sold-0102  Sold-0304  Sold-0405 4 Sold-0203 4 Sold-9739 0506 Dividends 4 RANEC|
&

If this menu bar is lost at any time then [Ctri+Shift+M] will rebuild it. The menus item are:-

3.2 Menu Button B

This button will save and close Portfolio Manager. In addition if you hold the Shift down it will
close without a save.

3.3 Menu Button Load ASx

This will load share prices from http://www.asx.com.au with a 20 minute delay. If you have any
missing sectors in Stocks it will also ask if you want to reload the sector names. It should be noted
that this price load will be slower that the Load Yahoo.

3.4 Menu Button Load¥shon ASx ~

This will load share prices from http://yahoo.com.au (with a 20 minute delay for ASX), depending
of the exchange selected it also enable you to load share prices from any stock exchange in the
world.

If for example you want to load Micro$soft share price then you would set the stock code to
MSFT, the Mkt (column B) to NAS and select NAS in the button drop down. The Load Yahoo
button will now only load stocks with a Mkt of NAS. You would have to change it back to ASX
reload Australian share prices.
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3.5 Menu Button B

This will allow you to Buy more shares. When you click on this button you will get the following
popup screen:

[¥er: 08/May/2006] Buy/Add stock to your Portfolio 5'
Drake: I DMy 2006 Ell Contrack Mote Mo: I
Broker: QTD ~ | QuickTrade (35t George)
ackion: By - Buy Shates - Initial Euy

Stock Code: I | ,I (if not: in list, add code into *Stocks' and redo buy)
Mo of Shares I ﬂ
AF Price: I ﬂ

Mo Brokerage

Brokerage; (427,95 up to $21,500 or %6013 [+] )

GST:

i

Stamp Duky:

Total Cost: C Nome % Cash C Cashz  Cash3

Cancel |

’7 Cash Account to Debit:

i

You then select the date of Purchase, the stock broker, the type of buy action, the stock code, the
number of shares and price. The system will calculate the brokerage & GST. If you are using the
Cash accounts then you also should nominate the account where the transaction will occur.

The Buy and Sell screens use the worksheets Action, Stocks and Brokers to validate all details
entered. If applicable your brokerage, GST and stamp duty are automatically worked out
(according to the Brokerage and Settings worksheets) for any Buy or Sell order. In some cases the
calculated brokerage may not be correct, so just overtype the values to suit.

If the share you want to buy does not appear in the drop down list on Stock Code then you will
have to Cancel this function, go and add the new Stock code on the end of Stocks, load its price
with either Load ... button. Once you have done this then you can retry the Buy.

Once all the details are entered and you have press Ok, the system will then proceed to create new
entries in your Portfolio, Log and optionally Cash.
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3.6 Menu Button el

This button will enable you to sell all or part of any holding recorded in your Portfolio. Before
you can do a Sell you must firstly select the row of your Portfolio that you want to sell, when you
have select your row and clicked on Sell then you will receive a popup screen like:

[¥er: 08,/May/2006] Sell/Dispose of Stock 5[
Stock: /5T0 - SANTOS ~ FPO |
Dake: Img Contract Noke Me: I—
aelling Broker ETD - Etrade

Mo af Shares: I 2500 il
4k Price: I 11.46 il

Mo Brokerage: [

Brokerage: I 20,05 { 432,95 up to $30,000 or %0.11)
55T =.00

Starnp Duky: oo

MWone % Cash " Cashz Cash3

Cancel |

Met Proceeds: K25 179.05

Cash Account to Credit:
’;‘

1

All the details from the selected share will be displayed together with the calculated brokerage and
GST. If you want to sell all the shares then you would just click on Ok, where upon the selected
row in your Portfolio is removed and added to the relevant Sold-yyyy sheet (in this case Sold-
0506).

If you have changed the numbers of shares to less than the holding then only a proportion of shares
are removed and the initial buy Brokerage and GST will be proportioned accordingly.

In the above example if the user had changed the number of shares to 100 then there would be 50
shares still remaining in the portfolio and the original buy brokerage and GST would have be
reduced to 1/3, but in the Sold-0506 worksheet the buy brokerage and GST would be 2/3 of the
original buy costs. This means you can always sell part of a holding and the system should
correctly proportion all buy costs between what is left and what has been sold.

You may also enter a sell price of $0.00 if you want to do a complete write-off of your shares, in
this event you will be asked to confirm this. You would only do this when a stock goes bust, i.e.
like good old HIH.

If you sell a number of rows for the same stock on the same day, the software assumes that this is
really a single sell transaction for many rows of the same stock (this would normally occur when
you have purchased the same stock at different times in the past and you are now selling all or
part as one transaction).

As a result the software will proportion (based on the % of the total shares sold) the total selling
Brokerage, GST and Stamp duty across all the sold rows. If this event ever occurs you will be
informed of the number of rows (the comment Brokerage/GST proportioned is added to these
rows) effected by this special process.
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3.7

3.8

3.9

Menu Buttons | #Cash | $Cashz | $Casha

These buttons will create a new row on the corresponding Cash account ane leave your cursor on
the Date column in the relevant Cash worksheet See 2.1 above on the Cash worksheets for
example. These buttons will only appear when you have elected to use the cash worksheets via |
will be using the cash account(s) in Settings.

Menu Button e

This button will perform a cash transfer from the current active Cash worksheet to another
nominated Cash worksheet. If for example you where in Cash and you clicked on this button and
entered 100 in the Amount field, and clicked on Cash3. ie:

Fd Microsoft Excel - PF-Demo.xls — 1ol x|
@ File Edit view Insert Farmat  Tools Data  Window Help Type aquestion forhelp [« 2 @ X

DEER| SRAY P BER-<|v-o-la s a2l e

Transfer from Cash x| - R
aahdo@m O Ba Ti i E=E |8 %, W% [EE EH- A
Amount:
&’] Load AS%  Load ¥ahoo ASY = | Buy | Sell | $Cash | $Cashz 1o r | ShareInfo.., = | Special... v | GoTo.., = [ H ‘? -
- 3 Date 06 May/2006 EI
A B € D E ‘ J [ K 4l
FinYr| Date |Trans| Debit | Credit |Ch [ |°Aount Amt]C |Primary Cash Aced

D5/05]| 30/Apr2006|Fee 500  czhe o0

0506] 01/Apr2008 1.000.00 .00

0.00 0.00 ok | . ,| .00
Balance: -

u|m|m|a. w I\J|—‘

Ready Calculate A

When you press Ok the system would then create a $100 debit in Cash and a $100 Credit in
Casha.

Menu Button Add Dividend

This button works like the Sell button in that you have to select a row on your Portfolio or select a
row on any of the Sold-yyyy sheets to nominate the share that you want to add a dividend for.
When you do select a share and click on the button you will get the following popup screen:

[¥er: 08/May;/2006] Add Dividend and/or Dividend Reinye ﬂ

Share: PZDD S5TO - SANTOS  FPO |

Dividend Date: I DE\IIIMB'}."II?DDE\ El

Cents Per Share:

Dividend &mt: ¥ Cash " Cashz ™ Cash3

1

’7 Cash Account to Credit:
L :

Dividend Reinvestment:
’7 Dividend Annk:

Mew Shares: I ﬂ

Imputation Credit:
UnFranked

Capital Return:

JInR

Franked: ‘iithHolding Tax: I—

Gross Yalue: Managmenk Fees: I— ggﬁa&?;ﬁ;i%ed
Met Yalue: Cheque Mo: I—

Camments:

Ok Cancel |
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The system will work out the number of shares from the selected row. The first thing to do is enter
the Dividend Date and the Cents Per Share.

When you enter the Cents Per share the system will (as you type) dynamically derive the
Dividend Amt, Imputation Credit and Franked amounts assuming the share is fully franked. If
any of these amounts are incorrect then you can still overtype the values to match your actual
dividend.

You can also nominate a Cash account to credit, and if the shares are from Dividend Reinvestment
then just enter the DRI Dividend Amt and the number of New Shares. The system will effectively
do a Buy for the additional shares from your DRI.

Any dividends that have withholding tax, fees or Capital Return can also be entered on this screen
and these additional details will be recorded. Any Capital Return amounts will also be recorded in
column N on in Portfolio worksheet.

When you click on Ok a new entry will be created in the Dividends Sheet and optionally on Cash
and if you entered any Dividend Reinvestment then the system will also create a new entry in your
Portfolio to account for you new shares.

3.10 Menu A&dd...~

This menu has a number of sub menu options all related to adding other miscellaneous items, these
sub items are:

3.10.1 Add ... B Capital GainfLoss

This will allow you add a one off Capital Gain or Loss on to your Sold-yyyy worksheet. When
you select this option you will see the following popup:

Add Miscellaneous Capital Gain/Loss x|

Buy Date: I 08 May 2006 E||
Sell Date: I 06 /May 12006 El
Amount: I " Gain ¥ Loss

Description: I

ok Cancel |

You can then enter the date the item was obtained and the date it was sold together with the
amount and if it was a gain or loss and a description.

The system will then add this row into the relevant Sold-yyyy worksheet so all calculations will
now reflect the capital gains/loss event.

3.10.2 Add ... % Cash Transfer

i

This option is the same as and will invoke the Cash Transfer popup.

3103 Add.. # Cah#land # Cash#Z gnd $ Cash#i
This option works the same as the Add Cash buttons.

3.10.4 Add ... Broker Code
Use this option to add a new Broker row in Brokers.
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3.105 Add Buy Action Code
Use this option to add a new Buy Action code, as used are used in the Buy screen.

3.10.6 Add Cash Transaction Code
Use this option to add a new a Cash Transaction code, as used on the Cash worksheets.

3.10.7 Add ... T ManuallogEntry

All entries on the Log sheet are automatically created, if however you ever need to add your own
manual Log entry then this option will allow you to.

3.11 Menu Shate Infa... -

All options with this menu apply for the selected stock code, so if you put your cursor on a stock
code it will use that stock code, otherwise an input box will prompt the stock code. In addition you
MUST be logged on the internet for any of these options to work.

3.11.1  Share Info ... Infarmation ¥ 54 Announcement »

Any selection within these submenus will open up your browser into the relevant ASX webpage
for the selected share. You can then use the Browser to obtain all the required details.

3.11.2  Share Info ... Chart »

This option will create two charts (using High, Low & Close, Close and Volume) for the selected
time period for the selected stock code. The price data for the charts is automatically downloaded
from the web and saved in the PriceData... worksheet.

3.12 Menu Seecial... -
This menu is the “everything else” items that are not commonly used, the option available are:

3.12.1  Special ... [El Calculate
This will perform a workbook F9 re-calculate

3.12.2 Special ... fuikomatic Price Load

This will allow turning on or off automatic web price loads. You will be presented with the
following popup screen:

Set Auto Price Load Fegquency ﬂ

Last Price Load: 9/08/2005 4:00:00 P

Disable Auto Price Load: v

Load Frequency in Mins: I {in Minutes)

Check Buy/sellat Alerts: r

Load Fram:
’75 ¥ahoo " asH Quit

To activate automatic price loads, un tick the “Disable Auto Price Load” and then select the
update frequency in minutes and nominate Yahoo or ASX load. When you have made your
selections and clicked on Set, then every “Load Frequency in Mins” minutes the price will
automatically update. To turn off again just use “Special -> Automatic Price Load” and tick
“Disable Auto Price Load”
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3123  Special ... [E ToogleRecalculate

This will toggle workbook calculation from Manual to Automatic or Vis versa. Automatic
calculation is normally turned off in Portfolio Manager for performance reasons

) A ' z '
3.12.4  Special ... 21 Sort fccending 5 4 &) Sort Decending

If you want to re-sort any worksheets by a particular column (for example Date in Portfolio) then
just select the whole column and then use these options to sort the worksheet ascending or
descending.

3.12.5 Special ... (8) ProtectionOn 54 ©w  Protection Off

Most of the worksheets in Portfolio Manager have “worksheet protection turned on to prevent
accidental overtyping of formulas, however, in some rare cases you may wish to view, alter even
correct a formula. If you are trying to type into a field that protected you will get the following
message:

Microsoft Excel N x|

The cell or chart ywou are trying to change is protected and therefore read-only.
! To madify a protected cell or chart, First remove protection using the Unprotect Sheet command {Tools menu, Protection submenuj, You may be
prompted for & password,

As a general rule you should never have any need to change a formula with your data, if you are
then you are not using the system correctly, and you should seek assistance about what you are try
to do.

If you do turn Protection Off then it is possible to corrupt the worksheet structure and/or
formulas, so great care should be taken in this situation.

Note: Using Upgrade will regenerate any “broken’” formulas.

3.12.6 Special ... 'l SaveBackup Copy

This menu item is used to create a backup copy in a \Backup subdirectory. The backup copy has a
“-Bkup-yyyymmdd” added on the end of the file name (where yyyymmadd is the current date).

3.12.7  Special ... ¥ Share Comversion

This function will enable you to perform any of the following conversions on the selected
Portfolio stock:

» Share Takeovers,

» 50% Share Splits, i.e. when you have 1000 ABC and they exchange it for 500 XYZ and
500 DEF.

Share Restructures, i.e. 10 for 1 consolidation.
ASX Code change,

Pay Instalment Receipt,

vV V V

» Other similar Share conversions.

When selected the popup screen will appear as:
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Ed Micrasoft Excel - PF-Demo.xls Share Takeover/Rename;/Conversion 1' —I—I' =] ﬂ
File Edit Wew Insert Formak  To Type aquestion forhelp = 2 @ X

0 = mlEar e s 2 [TOLLHOLDES FPO |
fatavid @@ lea of [foemersen s BA[EE| -2 A
Date:
B | Load Asx | Load yshoo asx - | Buy | Se e I ﬂﬁfMaWZﬂﬂﬁgl gecial,, = | GoTo,,, R
EB hd 23 Type! I Take aver ~[ Petshare Inst Amt:l +
[ T A ] C D j | [ [ L [l
1 | Fin¥r Date Action [Bkr |Sk i Price|BuyValue | Brokerage| GST
05/06] 25/0ct/2006|Buy . |ETD [TC | Converting 2353 TOL to: 12.200] 19,520.00 29.95 3.00
| 3 0608 | 26/0c1/2006(Buy  [ETD [TL | ho of harest [ 2353 ﬂ 4.110| 2055000 2995 300
| 4 |05/06| 31/0ct/2005|Buy  |ETD |57 = 11.350| 24 87000 10.00{ 1.00
5 |05M06|01/Dec/2005(Buy  |QTD [AC | StockCode: [7op =] ASH 16.150| 4.990.35 10.00( 1.00
05/06 |0B/Ma /2006 | Buy QTD |TC 13.800| 4599560 2541 254
7 |05/06|06/May/2006(Buy  |QTD [Ch AND ... (Outiona! 0% spit for 2nd Stock) 9900 459950 25.41| 254
(004 11Mey/2004|Buy |OTOITE | i opshares: [ 10000] 391000 26.41| 254
ER I’ 83,935.45 156.13 15.62
10 Stock Code: I -
11
l:'l""rtl Eee] | { 5old-0506 _f Dividends Aty RANECY
12.365 4

All of the above conversions will be applied to all holdings for the nominated stock (in the above
example all the TOL rows have been selected) and the original $ outlay will be preserved (except
for a Instalment Receipt where the initial buy price will be increased) by adjusting the initial buy
price and the number of new shares to equal the original $ outlay. All conversion operations will
be logged in the Log sheet and a comment will also be added to the Portfolio sheet.

In some rare cases the conversion calculations may result in fractions of shares for some or all of
your holdings, if this is the case you will be warned and you will have to correct the number of
shares manually.

If the conversion also included a capital return then you should use the Add Dividend function
to record the capital return component before applying the conversion.

3.12.8 Special ... Capital Return
This is just a place holder that will prompt you to use the Capital Return option in Add Dividends.

3.12.9  Special ... 3 Pay by Direct Credit

This function takes you to the OrderForm worksheet where you can enter your details and create
an Order. The bank account details are also displayed for Bank to Bank payments.

3.12.10 Special ... Pay by Credit Card

This function opens up your web browser at http://www.paymate.com.au. Please note that if you
pay by Credit Card there are some additional fees and charges.

3.12.11 Special ... * Upgrade tersion
Every now and again a new version of Portfolio Manager will be released and if you retrieve the
Broadcast it will notify you that a new version is available for download. Before you use this
function you must do the following:

» Download from this website the latest copy of Portfolio (and Upgrade, if requested).

» Unzip Portfolio (and Upgrade) to your windows desktop. That is make sure that the latest
unzipped copies of Portfolio (and Upgrade) are on your desktop.

» Re open your current copy of Portfolio and use “Special -> Upgrade Version” menu
function.

»  Confirm the details when prompted.

» Close Excel down and reopen your upgraded copy portfolio (the filename will remain

unchanged).

The upgrade process will not delete your old copy, but will rename it with a “-Old-yymmdd”
suffix, so if there are any problems you can still go back to the original version.
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If you get stuck, then please contact Portfolio Manager support and we can perform the upgrade
for you and assist you in the process.

3.12.12 Special ... Mew Reaqistration Key

If you have been issued with a new Registration key because the current one is about to expire
then you can use this option to enter the new Registration number to replace the older one.

3.12.13 Special ... & Daly Eroadcast

Once a week when you open Portfolio Manager it will display a general Broadcast message (if it
exists and you are logged on to the net and you are not holding the SHIFT key down). This
message will advise of any bugs, new versions, and any important information to users of
Portfolio Manager. This option will also allow you to redisplay this message.

3.12.14 Special ... ¥ Delete Selected Row

This option will delete the selected row on the active worksheet. You may wish to use it if you
want to manually undo previous operation. For example if you did a Buy then you could undo it
by deleting the rows created in Portfolio, Cash and Log.

3.13 Menu &aTa... ™

This menu gives you a fast alternative (rather that the worksheet tabs) way to go to any worksheet
in Portfolio Manager. The last option in this menu (Refresh Menus) will rebuild the menu bar and
apply any auto cash operations. Use this option if you have renamed an existing worksheet, or
added your own worksheet or want to apply an auto cash without reopening Portfolio Manager.

3.14 Auto Filter On/Off

This button will toggle Excel’s “auto filter” feature on or off. This function will allow you to only

display selected rows based on the filter criteria you choose. You can choose as many criteria as
required.

For example while in your Portfolio if you clicked on “Auto Filter” button then little drop down
selections Ll will appear on each column heading, eg:

[E3 Microsoft Excel - PF-Demo.xls =10 5[
File Edt Wew Insett Format Tools Data  Window Help Type aquestionforhelp = 2 @ X
DEHE(SRY fR@ o o (@ -HU WD -0,
QR AEE| Y EE 2 -uw-[B]z U | =SEEE|s %, W@ i .
[ | Load aS¥  Load ¥shoo ASX » | Buy  Sell | $Cash | $Cashz | $Cashd 4% | Add Dividend A&dd..~ | ShareInfo... = | Special.. = | GoTo...~ El2| .
wsPortfolio - & =fPa
A E C D] E F G H \ J K L =
| 1 [Fin'~ Date |~ |Actic~|Bk~|Shal~|Name ~|Sector ~|#Shar | Prii~|BuyVall~| Brokerai~| GS~
| 2 |0506| 25/0ct/2005(Buy  |ETD |TOL  |TOLLHOLDGS FPO Australian SE 1,500(12.200( 19,520.00 2995 3.00
| 3 |0506 | 25/0ct/2006(Buy  |ETD |TLE  |TELSTRA CORPORATI |Telecommunication Services 5,000( 4.110] 20,550.00 2995 3.00
| 4 |0508(31/0ct/2005|Buy  |ETD |STO  |SANTOS  FPO Australian SE 2,200(11.350| 24 570.00 10.00( 1.00
| 5§ |0506|01/Decf2005|Buy  |QTD [AGL  |AGL FPO Australian SE 309(16.150( 4,990.35 10.00{ 1.00
| B |05/06 [06/May/2006(Buy  |QTD|TOL  |TOLLHOLDGS FPO Australian SE 362(13.800( 439560 2541 254
| 7 |05/06|06/May/2006|Buy  |QTD [CML  |COLES MYER FPOD Food & Staples Retailing 505( 9.900( 4,992.50 2541 2.54
8 |03/04]11/May/2004|Buy  [QTD[TOL |TOLLHOLOGS FPO Australian SE 3591[10.000] 3510.00 2641] 254
19 | 83,935.45 156.13 15.62
Wy w3, Portfolio JEEEI / 5o0ld-090 )g-010 0304 J Sold-020 /- { Dividends M= R D3|
Ready Calculate v

You can then click on any of these dropdown selections and choose a value for that column. For
example in the sample below, TOL has been chosen:
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rosoft Excel - PF-Demo.xls

: =1k
Flle Edit VWiew Insert Format Tools Dakta  Window Help Type aquestion forhelp =2 8 X
DEEREQY | BB v -o-|@ = -2 5|40 -0,

Rtatad @ 2 EE 2 w-[Blz u|=EEESE 8 %, @0 i .
EE—’:] Load £5% | Load Yahoo ASY = | Buy  Sell | $Cash | §$Cashz | $Cash3 | £+ | AddDividend Add...=  Share Info... =  Specal.. v  GoTo.., * B3 H 7 .
wsPortfolio = f =fFa
A B c [D] E F [ H | ] [ L[]
| 1 |Fin'» Date = Acti(vJBkLIShaFName - |Sector ~|#Shar =| Priiv|BuyVal ~| Brokerai»| GS~

| 2 |05M6| 25/0ct/2005(Buy | (Al TOLLHOLDGS FRO Australian 3E 1,600{12.200| 19,520.00 2995 3.00

| 3 |0508 | 25/0ct/2005|Buy TELSTRA CORPORATI |Telecommunication Serices 5,000 4.110| 20550.00 2995 3.00

| 4 |05/06| 31/0ct/2005Buy SANTOS  FPO Australian 5E 2,200(11.350| 24 570.00 10.00) 1.00

| 5 |05/06|01/Dec/2005(Buy AGL FPO Australian SE 309(16.150( 428035 10.00( 1.00

| 6 | 05/06 |06/May/2006 (Buy TOLLHOLDGE FPO Australian 3E 362|13.800| 429560 26.47( 2.64

| 7 |05/06 |06/May/2006 (Buy COLES MYER FPO Food & Staples Retailing S05| 9.800| 429350 25.47( 254
8 |03:04 |11/May/2004 [Buy TOLLHOLDGS FPO Australian 5E 391]10.000] 3 210.00 25.41] 2564

ER 83,935.45 156.13 15.62
ETal i

Stocks |4 »

Ready Calrulate: y

E3 Microsoft Excel - PF-Demao.xls _ ol x|
File Edit ‘Wiew Insert Format Tools Data  Window Help Type & question for help [« & X
DEeEHE SRY BB 2. o |8 2 -2 5| ill 4 100%
Gfa% a9 R 7o -w - [m]r o= [E] s 8 .
E] Load AS¥ | Load Yahoo ASH «  Buy  Sell | $Cash | $Cash2 | $Cash3 | £+  AddDividend | Add...~ | Share Info... = Special... - | GaT -
wsPortfolio = & =fFa
A B C D E F G H | J K L [=
| 1 [Fin'~ Date v |Actic v|Bk |Shai ~|Hame ~|Sector ~|#Shar | Prii=|BuyVali~|Brokeray~| GS~|—
| 2 |0506| 25/0ct/2005(Buy  [ETD |TOL  |TOLLHOLDGS FFO Australian SE 1,600 12.200( 192,520.00 29.95( 3.00
| B | 0506 06MMay2006|Buy  |QTD|TOL  (TOLLHOLDGS FRO Australian SE 362|13.800( 499560 2541 254
| B |03/04|11/May2004{Buy  |OTD|TOL  TOLLHOLDGS FRO Australian SE 391|10.000{ 3,810.00 2541 254
20
[ 211
H 4+ [y Portfolio JEEEIS

stocks [ 4] Llj
VA

3 of 18 records found

Just click on to turn “Auto Filter” Off.

3.15 Hide/Show Columnsfd

This button will allow you to hide (or re-show) particular columns of the display. For example on
the Portfolio worksheet you would get the following screen:

Select columns to hide or show in Portfolio x|
“isible Hidden
4 Fin¥Vr -
B Date = i |
C Action
I Bkr
E Share
F Hame —
G Sector < |
H #Shares
I Price
J BuyValues
K Brokerage
L GET
M SDuty = | - |

=
]
=

Gt

You can then click on column names in the left hand (or visible) pane and use the > button to
move them to the right hand (or hidden) pane. When you have all the required columns nominated
then just click on Apply and all the nominated columns will now be hidden. The process can be
reversed by reusing the same function to move Hidden columns back to Visible.

3.16 Auto fit Columns =

Sometimes columns can become too narrow to display their data in which case lots of “#”
characters are displayed in their place, for example:
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E3 Microsoft Excel - PF-Demo.xls 18l x|
@ File Edit vWiew Insert Format Tools Data  Window  Help Type aguestion forhelp = o & X
DEEHG &R Y BRI v-o-|@ = -2 2] [l 4 w0 .

@Rt A @ Y B 7 A -0 - B I U|E B % , e B A
[ | LoadASk  Load¥ahoo ASk - | Buy | Sell | $Cash | $Cash2  $Cash3 | 4% | AddDividend | Add...~ | ShateInfo... = | Special.. = | GoTo... Bl 7.
12 - B 122
A B c D E F G H | J K L hal
1 | Fin¥r Date Action |Bkr |Share |[Name Sector #Shares|Price BuyValug Brokerage| GST SDJ
| 2 | 0506 | 25/0ct/2005| Buy ETD [TOL |TOLLHOLDGS FPO Australian SE 1,800 2995 3000 O
3 | 05/06 | 25/0ct/2005 | Buy ETD [TLS |TELSTRA CORPORATI |Telecommunication Services 5,000(4.110 7995 3000 O
| 4 |05M0B|31/0c12005Buy  |[ETD|STO  |S&NTOS  FPO Lustralian SE 2,200 | it | A 20.550.00h G| 100
| 5 |05/08|01/Dec/2005 | Buy AGL FFO Australian SE 309 | st 10.00) 1.00] O
Fi | 0AMIR MR w2 41] 2 A, h
H 4+ H}Portfolio Stocksjﬁj »

Columns | and J in the above are displayed as “#####4#”, if you now click on the “Auto fit
Columns” button then all the columns widths are adjusted so that their data can be displayed, ie:

Ed Microsoft Excel - PF-Demo.xls =10 1[
File Edit Wiew Insert Format Tools Data  Window  Help Type aquestion forhelp = 2 8 X
DEEHXRESRAY | BB \w-c-|@ = -2] I [l 4 100% -3
Bafata A Sl @ g T =0 B B % EH-d-A-
E] Load ASY | Load ¥ahoo ASH - | Buy | Sell | $Cash | $Cash?  $Cash3 | +% | Add Dividend  Add...~ | Share Info... | Special... = | GaTa... = (5| ,"—1 k74 .
12 - B 122
A B C D E F G H | J K L 4]
1 [Fin¥r Date Action |Bkr |Share [Name Sector #Shares| Price| BuyWalue | Brokerage GExchJ
| 2 |0506| 25/0ct2005(Buy  |ETD (TOL |TOLLHOLDGS FPO Australian SE 1600 12,2000 19 520.00 29.95] Tow
| 3 |0506) 25/0ct2005(Buy  |ETD (TLS  |TELSTRA CORPORATI (Telecommunication Senices 5000 4.110[ 20,550.00 28.96) 3.00
| 4 |0506| 31/0ct2005(Buy  |ETD |STO  |SANTOE  FFO Australian SE 2200|11.350( 24,870.00 10.00( 1.00
| 5 |0506 | 01/Dec/2005(Buy  |QTD|AGL  [AGL FPO Australian S5E 309|16.150] 499035 10.00) 1.00
R 0AMH B Apstralian 411 2 A4 T
H 4+ H[}Portfolio ot 000 : 405 o 5 Stocks]4J 3

3.17 Help %

Currently this button will display contact information and take you to the web site where you can
download this help document.
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4 Sample Portfolio Manager Transactions

4.1 Buying a Share

Page 25 of 32

Firstly make sure you have the share (NAB in this case) listed in Stocks worksheet, if not add it to

the end of your Stocks:

Microsoft Excel -

File Edit VYiew Insert Format Tools Data  Window  Help
D& SRV BR SARERIL TRg T ) o

Arial

athhawsa %S

»

-9 -8B 1 U]

%

Type a question for help

40 00
G0 .0

=100 x|

-0 X

H Load ASX | Load Yahoo ASH | Buy | Sell | $Cash | $Cash2  §Cash3 | €% | Add Dividend | Add... =  ShareInfo... = | Spedial..~ | GoTe..~
Als v X A& nab
A =] C D E F G H | J K L i} i 8] Pl
1 [Code Mkt [Compamy Hame Sector BuyAt]|Sellat] Last § +/- |Daiby Gain| Bid | Offer | Open | High | Low Volume [%Char—
LAGL LSY (AGL FRQ Lustralian SE 16.150(-0.150 -278.10 16.150|16.240|16.070| 1,177 629 3
LAPA ASH (AU PIPELIMN UMITS | tilitie:s: 3570|-0030 3910 3920 3870 243,558 ik}
LEIEN ASH (BEM BANK FPO Banks 11920 -0 030 11.800| 12.000| 11 860 123,864 -0t
| 5 |CBA  |ASK |CWLTHBANK FPO Banks 41.140|-0.680 41.550| 41 B70| 41 130( 4,215331 1.
| B |CBAPA |ASK |CWLTHBANK PREF  (Banks 204 .600) 0730 T T T o 1.
LCML ASH |COLES MYER FPO Food & Staples Retailing 9.9001 -0.090 9.960(10.020( 9.840| 3333922
i CMLPA |ASH |COLES MYER 6.5% P [Food & Staples Retailing 103.900| 0.000 i i i o
iMSFT MAS [MICROSOFT CP Mascac SE 42.077| 0338 43.631)40.535| 41.877| 42.323| 41.554| 65,455,976
£ SGBPB |ASH |ST.GEORGE B36%P  (Banks 104120| 0000 i i i a
lSTO ASH [SANTOS  FPO Australian SE 11460| 0050 11000 11.480| 11 .550| 11 .320| 2,025 747
112 |TLs ASH |TELSTRA CORPCRAT! | Telecommunication Services 3840|-0010f  -50.00 3.840( 3.830( 3.820|42144 252
| 13 |ToL ASH | TOLLHOLDGS FPO Australian SE 13:800|-0.080f  -125.00 13.700|13.890|13.700 800 920
14 |wiciy | ASH [WOOLWORTHS FPC |Food & Staples Retaiing 17.030| 0.020 1686017 210|16.860( 3,589231
15 [riak] [ -346.10
[
(17| -
Stocks ¢ Byshare | <] | LlJ

Enter return and next click on Load Yahoo:

Microsoft Excel - PF-Demo.xls =10/ x|
File Edit Wew Insert Format  Took Data  Window  Help Type aquestion for help =2 @ X
DE2EHG S@AY | 4BR-< | v o-|@ = -8 2] {1l 40 3,
BahanE| P Ra Zisa -5 -|B 7 U] B %o AR .
E] Load ASK | Load Yahoo ASK + | Buy | Sell | §Cash | $Cashz  $Cash3 % | Add Dividend | Add... = | Share Info... = | Spedial.. = | GoTo... = -
Ald M Fe NAB
A B C D E F G H | J K L i} M o -
1 Code Mkt [Company Hame Sector BuyAt|Sellat] Last | % +- [Daily Gain | Bid | Offer [ Open | High Low Volume | %CH—
2 acL [asK [acL FPO Australian SE 19.150) 0.220 B7 .95 19.130] 19.200| 13.990 503,938
3 Apa [ASX [AUPIPELIN UMITS Ltilities: 4.410(-0.040 4.440( 44500 4400 133,336
4 |BEM ASH |BEM BANK FPO Banks 13.520| 0360 13.400| 13650| 13400 45,880
S CBA  [ASH [CWLTH BANK FPO Banks 46.100) 0.300 461000 46470| 45.840| 3,183,802
B | CBAPA [AS) [CWWLTH BAMK PREF  |Banks 199.310( 0.000 s, (188550 | 199280 11,512
= ASK |COLES MYER FPO Food & Staples Retailing 10.800) 0.250 126825 10.680) 10900| 10600| 5859937
8 CcMLPA [ASY [COLES MYER 65% P |Food & Staples Retailing 103.800( 0.000 TiA, P2, i, o
9 MSFT_[MAS [MICROSOFT CP hasdag SE 42,077 0.335 43631 | 40535 41 577| 42323 41.554| 65455976
10 [MAE _ llasy [MAT. BAME FPO Auztralian SE 36.570)-0.010 36.680) 36680 36160| 4767853
11 |SGBPB |ASX [ST.GEORGE B.36%FP |Barnks 102.700( 0.000 MiA | 102700102 700 o
12 |5T0 AZY |SANTOS  FPO Australian SE 11.860) 0.380 836500 11.5000 11870 11.500| 1,589,450
13 |1Ls AZX |TELETRA CORPORATI Telecommunication Services 3.850( 0.070 35000 3790 3850 376033595205
14 |toL ASH | TOLLHOLDGS FPO Australian SE 13100 -0670| -1 57651 12990 13280| 12910| 4,785,352
15 fwioly | ASH WOOLWORTHS FPO  Food & Staples Retaiing 18.860) 0.310 18.7500 18.910| 18.630| 3,078,044
16 19625
17 -
Stocks 4 ByShare JLU ¥
V

Note that while NAB has loaded (at row 10), the sector it has given is “Australian SE”. If you
it out sector and use Load ASX to get

want the correct sector you should overtype it or clear

automatically load the correct sector description.
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The next step is to click on Buy, and you will see the Buy screen:

[¥er: 08,/May,2006] Buy,/Add stock to your Portfolio il

Date: I 06 May/ 2006 El Cankrack MNake Mo I
Broker: I oD .I QuickTrade (St George)

Action: By Shares - Initial Buy

Buy -

Stock Code: I | ,I (if not in list, add code into 'Stocks' and redo buy)
Mo of Shares I il

At Price: I ﬂ

Mo Brokerage [

Brokerage: I ( $27.95 up to $21,500 or %6013 [+] )

GST: |—
Stamp Duty: I—

Cash Account to Debit:

Tatal Cast: i " Mone % Cash € cCashz " Cash3

Ok | Cancel |

and enter you share details by selecting your stock code in the drop down box on Stock Code

[Yer: 08/May/2006] Buy,;Add stock to your Portfolio ﬂ

Crake: I 06May,/ 2006 Ell Conkrack Make Mao: I
Broker: I oTD v| QuickTrade (St George)

Action: Buy Shares - Initial Buy

Buy -
Stock Code: v| (if not in list, add code inko 'Stocks' and redo buy)
ZBA -
Mo of Shares CEAPA
ML
Ak Price: CMLPA
MSFT
Mo Brokerage g?gpﬁ =
Brokerage: ( $27.95 up to $21,500 or %013 [+] )
GST: I
Skamp Duky: I
Cash Account to Debit:
Tatal Cost: ot " Mone % Cash " cashz (" cash3

E

Cancel |
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and then entering the number of shares, 500 in this case:

[¥er: 08/May,/2006] Buy/Add stock to your Portfolio ﬂ

Date: I O6jMay (2006 Ell Conkrack Maoke Mot I
Broker: I QTD .I QuickTrade (St George)

Actkion: By - Buy Shares - Initial Buy

Stock Code! NAB ~| MAT.BANK FPO
Mo of Shares 500 ﬂ

At Price: I 36.57] i’

Mo Brokerage

-
Brokerage: I 25,41 { $27.95 up ko $21,500 or 0,13 [+])
GST: 7 54

Skarnp Duky: I

Cash Account to Debit: ——————————————
Total Cost: 18,312.05  Mone % Cash € Cashz { Casha

ok | Cancel |

You will notice that the brokage is automatically calculated based of the selected broker.

When you click on Ok a new entry for NAB in your Portfolio will be created:

Fd Microsoft Excel - PF-Demo.xls: = =131 x|
@ Fle Edit Miew Insert Format  Tools Data  Window  Help Type aquestionfor help =2 & X
DEEa SRV iBR-< 9-0- @& = -2 % |1l 4
Mt AT O i -w =B ¥ U : gie DA
[ | Load AS® | Load Yahoo ASX ~ Sell | $Cash  $Cash2 | §Cash3 | 3 | AddDividend | Add...~ | ShareInfo.. = | Special.. = | GoTo..~ |[EE B3 | &) % .
e A 122
A B c D = F G H | J K [
| 1 [Fin¥r Date Action |Bkr [Share |Name Sector #Shares| Price| BuyValue | Brokerage| GST
| 2 |05/06|06/May2006(Buy  [QTDMNAE  |MNAT. BANK FPO Australian SE 500|36.670| 18,286.00 2541 264
| 3 |05M06) 25/0ct/2005(Buy  |ETD |TOL  |TOLLHOLDGS FPO Australian SE 1500) 12,2001 12,520.00 2995 3.00
| 4 |0506| 25/0ct/2005|Buy  |ETD [TLS  |TELSTRA CORPORATI |Telecammunication Services 5000 4.110) 20,550.00 2995 3.00
| 5 |0506| 31/0ct/2005|Buy  |ETD [STO  [SANTOS  FPO Australian SE 2.200{11.350) 24 870,00 10,00 1.00
| B |0606| 01/Dec/2005|Buy  |QTD [AGL  [AGL Fp\_ x| E 309|16.150| 4,990.35 10,00 1.00
| 7 |05M06 (D6/May/2006(Buy  |QTD (TOL  [TOLLHOLDG E. 362|13.800| 429560 25.41| 254
| 8 |0506|06/May2006(Buy  [QTD|CML  |COLES MYE i S les Retailing S04 9.800| 429950 2641 264
9 |0304) 11/ay2004|Buy  |QTD|TOL  |TOLLHOLDG \..,) ol E 391[10.000] 3.210.00 25.41] 264
10 et 181.54 18.16 —
Stocks | 4[] »
VA
In addition a new entry in Log will be also be created:
E3d Microsoft Excel - PF-Demo.xls - |E| 1'
@ File Edit Wiew Insett Format  Tools Data  Window  Help Type aquestion for help = 2 & X
DEEx SRV BB v o-|@& =20 44w -2,
Ba ®3 ™ S F W) T ol Narow 10 -|lB F U § B % , WR|EET-DA-
Load ASY% | Load Yahoo &SX ~ Buy  Sell | $Cash  $CashZ | $Cash3 3%  AddDividend | Add... = | Share Info... » | Special... ~  GoTo... + E3 H 7 bt
A2 - A
A B C i E F G H [ J ] K L M M o | P ] Qz‘
| 1 Finfr Date | Action | Broker | Share |#Shares| Price | Value |Brok |GST|Sduty| Total |CHoteNo —
2 | 03041 08 Mtay2008 | Buy  |QTD |MAR S00| BETO0( 391000|2641( 254 -3 5
3 0304 [11Mayi2004 | Buy  |QTD |TOL 91| 10.0000( 391000 2641( 254 -3 5
|<‘4 » M ByTimeData PriceData-240-1mo Charb-YOHLE  Chart-Close  Exchanges & Brokers & Trans 4 Actions
Ready Calculate

Your Buy is now completed ...
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4.2 Selling A Share
Select the share you want to sell from Portfolio, BEN in this case:
Ed Microsoft Excel - PF-Demao.xls - E||5|
Flle Edit Wew Insert Format Tools Data  Window  Help Type aquestion forhelp |+ 2 @ X
DEER &GV |$BRR-F 9o |@ 2 -2 4§40 -3,
T ®P A P e T o <0 -8B F U S % , W LoD A
Load A5% | Load Yahoo ASx -+ | Buy  Sell | $Cash | §Cash? | $Cashd 3 | Add Dividend | Add..~  Share Info..~ | Specal..~  GoTe..v BB EI ) ot
Al0 - F
A B c [D[ E F G H I J K L]
1 | Fin¥r Date Action |Bkr_[Share [Name Sector #Shares| Price| BuyValue | Brokerage| GS
| 2| 0304 1/May/2004)|Buy QTD(TOL  |TOLLHOLDGS FRO Australian SE 391 10.000)  3910.00 25.41] 2.8
| 3 | 0506 06/ ay/2000|Buy QTD [MAB  |MNAT. BAMK FPO Australian SE 500 36.570| 16.265.00 25.41] 2.8
| 4 | 0506 | DBEMay/2008|Buy QTD(TOL  |TOLLHOLDGS FRO Australian SE 362(13.800| 4599560 25.41] 2%
| 6 | 0506 | 08/May/2006|Buy QTD (CML  [COLES MYER FPO Food & Staples Retailing A05| 9900 4859950 2541 2%
| 6 |0506( 01/Dec/2005|Buy QTD [AGL  [AGL FPO Australian SE 30916150 499035 10,00 1.0
| 7 | 0&M&| 31/0ct2005|Buy ETD [STO  [SANTOS  FPO Australian SE 27200(11.350| 24 570.00 1000 1.0
| B | 0506| 25/0ct/2005|Buy ETD [TOL |TOLLHOLDGS FRPO Australian SE 1,600]12.200]) 19,520.00 2995 3.C
9 0506 | 25/0ct2005) Buy ETD |TLS [TELSTRA CORPORATI [Telecommunication Services S000( 4.110] 20550.00 28.95 3.0
0506 | 10/)an/2005|Buy QTD [BEN  [BEN BANK FPO Banks 369|13.520] 4888.88 2541] 2¢
|11 107,209.33 206.95 207
2]
i -
W 4 v vi[yPortfolio JE R ¢ Sold-0405 Sold-0506 ¢ Dividends  dieTetal IRl 013
Ready Calculate Sum=58754, 29429 v
Click on Sell button and you will see the following screen:
[Yer: 08/May/2006] Sell/Dispose of Stock ﬂ
Stock: BEN - BEN BANK FPO |
Date: I 08 Mary 2006 El Contrack Maote MNa: I
Selling Eraker I QTD ,I QuickTrade (St George)
Mo of Shares: 363 ﬂ
AF Price: I 1352 i’
Mo Brokerage: [
Brokerage: I 25 .41 ( $27.95 up ko $21,500 or %0.13 [+])
GST: 2,54
Stamp Duty: I o
Cash Account to Credit:
Met Proceeds: M4 9p0.93  Mone % Cash  { Cashz O Cash3
Dk | Cancel |
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Review details and click on Ok, and a new Entry will be added to Sold_0506

@] File Edt Wiew Insert Format  Tools Data  Window  Help

DEEmn SR Y | $B2R-<T| oo |@& = -2 2 ||l 4 100% -3

A G| @ »? - arial =0 BB O B 25,

Load ASY | Load Yahoo ASX = | Buy §Cash | $Cashz | $Cashd £ | Add Dividend | Add...~ | Share Info... v | Spedal.. -

A10 - £ B/O52006
A B [0} D E F G H | J K I It =

1 Sell Date | Bkr |Share Name #Shares| Price | Value [Brokerage |GST|SDuty| $Sell Buy Date |BuyPrice E_‘
2 |DBMay2006I0TD |EEN  |BEEN BANK. FRO 369|13.520( 4 938838 2541|254 000| 4,960.93 10/1an/2005 13.520

3 |01/Decf2005|QTD |AGL  |AGL FRO 309|16.150( 4 99035 10.00(1.00| O0.00| 4,979.35) 01/Dec/2005 18.150

4 | 1T14A0g2006|QTD |BEN  |BEN BANK. FRO 500| 10.060( & 030.00 2541|254\ 0.00| 5,002.05] 171/40g/2005 10.000

5 |09/A0g/2005| QT |TLS TELSTRA CORFORATI S00| 4.560( 2 450.00 2541| 254| 0.00| 2,452.05| 16/0ct/1599 7400

6 | 09440972005 |QTD [CHL  |COLES MYER FPO 3| 9.830 e e SN 54|  0.00 23.50| 10/May/1993 7.080

7 | 094404/2005)QTD |[CML_|COLES MYER FPO 11| 550 | EEINIRERZES xlb o) 0.00]  86.47| 10/May/200d| 7560

8 - ##4# 0.00 17,504.05
Ex “-lt) 369 BEM Sold

10

11

12
EER -
W 4 v [3Sold-0506 JEREEREEME Stocks . Byshare  Bysector . ByTime ByTimeData PriceData-AO-1mo _{ Chart-woHLe | Chart-Close | Exch | 4| LI]_‘
Calculating Cells: 100%

The original BEN row in Portfolio has been removed:

icrosoft Excel - PF-Demo.xls —_10f x|
Eile Edit “ew Insert Format Tools [ata  Window Help Type aquestionforhelp v o @ X
DEEE/SRY & BA-F | v-c-|@ = -8 [l Hov -3,
At i @ 6| P B 2l 10 -|B F U B %, LR
Load AS% | Load ¥ahoo AS% = | Buy | Sell  $Cash | $Cash2 | $Cash3 | +% | Add Dividend | Add... = | SharelInfo... = | Special.. * | GoTo...
G2 h e
A B c 8] E F G H | J K
1 |Fin¥r Date Action |Bkr |Share |Hame Sector #Shares| Price| BuyValue | Brokerage
| 2 |0304 | 11/May/2004 Buy QTD(TOL  [TOLLHOLDGS FPO Australian SE 391(10.000(  3.21000 2541
| 3 |DADA | OB/May/ 2006 Buy QTD [MAE  [WAT. BANIK FPO Australian SE a00|36.570| 18,285.00 25.41
| 4 | 0506 | 06/May/2006 Buy QTD (TOL  [TOLLHOLDGS FPO Australian SE 362(13.600( 499560 2541
| 5 |05/06 | 0B/May 2006 Buy QTD [CML  [COLES MYER FPO Food & Staples Retailing 505 2.900( 493950 2541
| B |0506| 01/Dec/2005 | Buy Q7D [AGL  [AGL FPO Australian SE 30916.160(  4,990.35 10,00
| 7 |0506| 31/0ctf2005|Buy ETD [STO [SANTOS  FPO Australian SE 2200(11.350( 2497000 10.00
| 8 |05806| 25/0ct/2005 | Buy ETD (TOL [TOLLHOLDGE FPO Australian SE | 1,500)12.200 19,520.00 2095
9 0506 25/0ct/2005 Buy ETD [TLS [TELSTRA CORPORATI [Telecornmunication Services 5000 4.110] 20,550.00 29.95
| 10| 102,220.45 161.54 181
: : { { { { { { { stocl |4 || »
Ready L
And a new entry will be added to Log:
icrosoft Excel - PF-Demo.xls = (o) x|
File Edit Wiew Insert Format Tools Data  Window Help Type aquestion forhelp = 2 @ X
DEdag SRy fBER-< 9-o-|@& 5 -2 2 @@ -3,
fafa® AT P8 T adaron Jio =B £ U $ %, W A-.
Load A5¥ | Load Yahoo As¥ - | Buy | Sell | $Cash | §Cash2 | $Cash3 | £3 | Add Dividend | add... = | Share Info... = | Special... = | GaTo... = H ‘? it
A2 - 3
A B C D E F G H I [ J] K L b M o [ P | 3
| 1 |Fin¥fr Date Action | Broker | Share |#Shares | Price Value |Brok |GST|Sduty| Total |CHoteNo =
2 {0506 106 tary/2006 | Sell 01D |BEM 69| 135200) 498888 2641 284 000 496093
| 3 |05M06 | 06/Mayizn06|Buy  |OTD [BEM 69| 135200| 4,988 8% 2541254 -5016.83
| 4 | 06506 | 06MayZ006|Buy  |QTD  [NAB SO0| 365700 1%,285.00| 25.41) 254 -18,312.95
W 4 » M| ByTimeData PriceData-%A0-1mo Chart-YOHLC & Chatt-Clase  Exchanges £ Brokers 4 Trans 4 Actions

Your Sell is now completed ...
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4.3 Adding a Dividend

Select the row you want to add a dividend for, WOW in this case:

Ed Microsoft Excel - PF-Demo.xrls ol x|
File Edit View Insert Faormat Tools Data  ‘Window Help Type a question for help = = & X
DEd® S8R | fBER-<f| o c- @ = -2 2 [ o -3,

Mt ATE A s  Ziad w0 - uEEEE|S %, @8

Load ASH | Load Yahoo ASH = | Buy  Sell | $Cash | $Cash2 | $Cash3 | 3+ | Add Dividend | Add... = | Share Info... = | Special... ~
Ald - #
A B c D[ E F G H I J K |
1 |Fin¥r Date Action |Bkr |Share [Name Sector #Shares| Price| BuyValue | Brokerage| G
| 4 |05/06| 31/0ct/2005|Buy  |ETD |STO  [SANTOS  FPO Australian SE 2.200011.350| 24,970.00 10.00] 1
| 5 |05/06| 01/Dec/2005|Buy  |GOTD |AGL  |AGL FPO Australian SE J09(16.150 499035 1000 1
| 6 |D5/06 | OBMAay/2006|Buy  |GTD |NAE  [NAT BANK FPO Australian SE S00(36.570| 18,285.00 2541 2
| 7 |05/06 | 06/May/2006|Buy  |GTD|TOL  |TOLLHOLDGS FPO Australian SE 362|13.800| 499560 2541 =
| 8 |05/06 | D6/May/2006|Buy  |QGTD |CML  [COLES MYER FPO Food & Staples Retailing a0s( 9900 4999.50 2841 2
9 0304 | 11/May2004|Buy  |OTD|TOL [TOLLHOLDGS FPO Australian SE 391(10.000]  3910.00 2541 =
04/05 | 30640072004 [Buy  |QTD POHY [WOOLWORTHS FPO  [Food & Staples Retailing 111[11.620] 12.796.72 2541] 2
1 115,019.17 206.95 20
st ]| LIJ

Ready Calculate Sum=77453, 71686 v

Click on Add Dividend and you will get:

[¥er: 08,/ May,;/2006] Add Dividend andfor Dividend Rein ll

Share: 1111 WOW - WOOLWORTHS FPO |

Dividend Date: I USIME&'J‘ZDDE\' El

Cents Per Share:

Dividend Amt:

Cash Account to Credit:
|;' Mone % Cash " Cashz " Cash3

1

Dividend Armt:

MNew Shares: I ﬂ

” Dividend Reinvestment:

Imputation Credit:
UnFranked
Capital Return:

Franked:

withHolding Tax: I

(Wil aleo e cectictad

Managment Fees: I fram Cash Accounél
Cheque Mao; I

Gross ¥alue:

Met Yalue:

Comments:

ok Cancel |

A
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Enter Dividend Date and Cents Per Share, in this case 1/Aug/05 and 50 cents per share

[¥er: 08/May/2006] Add Dividend and/or Dividend Re il

Share: |1111 Wow - WOOLWORTHS FPD |

Dividend Date: I 01Aug 2005 Ell

Cents Per Share: s

Dividend &mt: CEG.G0

Cash Account to Credit:
’;“ Mone (% Cash " Cashz " Cash3

!

Diwidend Amt:

Mews Shares: I il

” Dividend Reinvestment:

Imputation Credit: | 555 o7
UnFranked

Capital Return:

Franked: 555.50 withHolding Tax: I

: W afeo be deducted
Managment Fees: I fiom Cash Account)
Net ¥alue: 555.5 Chegue Mo I

Comments:

ok Cancel |

The system will automatically generate Dividend Amt ($555.50), Imputation Credit ($238.07)
and Franked ($555.50) , these automatically generated amounts using Cents Per Share will be
based on a 100% fully franked dividend. If your dividend was not fully franked then these
amounts will be incorrect, in which case you can overtype them with the correct values.

Gross Yalue:

0EE [ |

The dividend in this case also had 48.5% withholding tax of $269.42, so the user enters this
amount in WithHolding Tax

[¥er: 08,/May,/2006] Add Dividend and,or Dividend Reiny: |
Share: |1111 WOW - WOOLWORTHS FPD |
Dividend Date: 01/bugi2005 E'l

if

Cents Per Share: 50

Dividend Amt: 555,50

Cash Account to Credit:
’;" Mone  {* Cash " Cashz " Cash3

]

Dividend Amt:

Mew Shares: I ﬂ

” Dividend Reinvestment:

Imputation Credit: | 595 g7
UnFranked
Capital Return:

Franked:

WithHolding Tax: I 269,42
(WAl afro be dedtcfed

Managment Fees: I From Cash Account?
Net ¥alue: 286.0 Cheque Mo: I

Camments:

ok Cancel |

Gross Yalue:

JECIEN
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Click Ok and the dividend will be added to Dividends
FA Microsoft Excel - PF-Demo.xls i =] 1]

@ File Edit Wew Insert Faormat Toadls Data  Window Help Type aguestionforhelp = o & X
DEHR(SRY |4 RB-C|(o-c- @z -2 U[BH o -0,
Mt ATE@ B i Fo kB2 U SEEE|S %, %38 Hi-3-A-
Load A5% | Load Yshoo A3 = | Buy | Sell | $Cash | $Cashz | §Cash3 | 4% add,.. = | Share Info,.. = | Special... = | GoTo... - | EH  E3 H 4 2
= 5
A B g D | E | F | 6 | H | | J [
| 1 [FinYr|Date Stock [Name |Cents Per Share |DRI SharesIDRI Div1Div Amt1imp Credit|WhTax]|Franked |I_|
2 |05/061 01/40g/20050 WO [WOOLWORTHS F jgldie i3 = 1= x| 23807 269.42] 55550
| 3 |0506 | 11/Aug/2005W0W  WOOLYWORTHE F 233.07| 269.41| 55550
4 |04/05| 30f4pr2005|TLS TELSTRA CORP F i Dividend/Capital Return added ,$555.50 deposited to Cash 94.71 221.00
5 |04ms 10¢May/2005|CML COLES MYER \n) MOTE: Wwithholding tax of $269,42 will be deducked from cash 35 R4 a3 16
E 0304 | 31 /May/2004| CMLPA |COLES MYER-PR 124.30 2590.04
| 7 |0304| 24/Jun/2004| 8P4 |AUST PIPELINE
| 8 |0304| 31/Mar2004 [ BEN BEMDIGO BAMNK 11293 263.50
| 9 10304 | 29/Mar2004| CBA COMMOMNYWEALTH B 133.74 3205
10 | 03/04 | 29/Mar/2004 ALUST PIPELINE = X
TR, Fortfolic f Sa 0 ) stc| 4] v

+ 100%:

Your Dividend is now added ... and in this case the system has also added and extra entry in
your cash for the withholding tax eg:

E3 Microsoft Excel - PF-Demo.xls =] ]
Fle Edit Wew Insert Format Tools Data  Window Help Type aquestion forhelp = 2 & X
Dl SRY | s BR-<C|o-c- (@ =2 5|l s o
BEtahdo@ @% e 2 arial -1 -|B fUIEEEH|S %, @0[¢E A -,
ﬁ Load A5% | Load ¥ahoo ASY ~ | Buy  Sel  $Cash  §Cashz  $Cash3 4%  AddDividend | Add... = | ShareInfo.. = | Special..~ GoTo.. =
D2 - A 26942
A B C D E F G H | J | K [ &
1 |Fin¥r Date Trans | Dehit Credit  [Cheque No|StatNo|TxnlD|Recon Amt|Comments |Primary Cash Account [
| 2 |0506) 01/A0g/2005 Tax 20842 0.00 [WOW Withholding Tax
| 3 | 0606 | 01/A0g/2005 (Div 556.50 0.00 [WOW Dividend
| 4 |0405| 02/3eps2004 [Buy |12 52667 0.00 (Buy 1111 WOW on 30/A09/2004
| 5 |0506) 1/May/2006|Sell 4,960.93 0.00 [Sell 363 BEN on 0B/May/2006
H 4 » w[\Cash 5

JETH ﬂj
v

*** END OF DOCUMENT ***
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